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Preface

About this User Guide
This user guide describes how to install and configure the DECcolor
Works printer driver. This printer driver is designed for use with the
Digital Series 500 color inkjet printers.

Note: The DECcolor Works printer driver is used for printing from
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA

Windows 3.1/3.11.
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA

Structure of this User Guide
This user guide contains 5 chapters.

Chapter 1, Introduction to the DECcolor Works Printer Driver
provides an introduction to the DECcolor Works printer driver, lists the
features and advantages of the driver, and provides a brief technical
description of how the driver works.

Chapter 2, Installing the DECcolor Works Printer Driver describes
how to install the DECcolor Works using the supplied diskette and
includes each of the steps to follow to complete the installation.

Chapter 3, Configuring the DECcolor Works Printer Driver describes
how to use the dialog boxes to configure the various options available
with the printer driver.

Chapter 4, Spool Manager and Despooler describes how to use the
DECcolor Works Spool Manager which manages communication
between the computer and the printer.

Chapter 5, Troubleshooting provides a list of answers to typical
questions and answers concerning the use of the DECcolor Works
printer driver.
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Introduction to the DECcolor
Works Printer Driver

Introduction
Welcome to the world of DECcolor Works, where printing is fast and
effortless and your output is customized for your specific printing
needs.

Using DECcolor Works, you can print - in both color and monochrome
- from popular PC applications (word-processors and spreadsheets) and
advanced drawing and imaging applications.

With DECcolor Works, your application software releases from the
printing process more quickly than with conventional Microsoft
Windows printing technology. In addition, you can leave all your print-
quality options turned on without sacrificing performance.

Components of the DECcolor Works Printing System

The DECcolor Works printing system consists of the following:

• The DECcolor Works printer driver for your Series 500 printer.
This includes an environment for configuring your printing
environment with a set of easy-to-use dialog boxes.

• The DECcolor Works Spool Manager which is similar to the
Windows Print Manager.

• The DECcolor Works Despooler which communicates print files to
the printer.

Each of these elements work together to provide an optimum color
printing environment for your printer.



2

Advantages of DECcolor Works
The DECcolor Works printing system is installed in the same way as
any other Microsoft Windows printer driver, but has some major
advantages over conventional Windows printing technologies. The
advantages of DECcolor Works are described below.

Dialog Boxes with Graphics

It's easy to select the printing options you need because with most
selections, the DECcolor Works printer driver shows you on-screen
graphics of how they will appear once printed.

Tabbed User Interface

It's simple to use and understand the printer driver because it uses the
new tabbed style of user interface made popular in recent Microsoft
software and the visual graphic style of Windows printing systems.

Richer Colors

Colors are richer and more true to the screen image because the
DECcolor Works printer driver uses color correction for screen-to-
printer color WYSIWYG (What You See Is What You Get).

Quality Photos and Graphics

Photographs look realistic and graphics appear smoother and of higher
quality because of the DECcolor Works printer driver's advanced
Diffusion dithering.

Faster Printing

DECcolor Works provides fast release of computer resources, allowing
you to spend maximum time working with your application. Over all,
print time is significantly shorter than with other printing systems, even
when the DECcolor Works printer driver is working in color or
interfacing with advanced devices operating at 24 bits per pixel.
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How It All Works
DECcolor Works is an advanced Windows printing system which
operates as follows:

The application is told by the printer driver that the printer is a raster
device that can render the entire image in a single band. The driver also
reports that certain advanced printing options are supported. All of
these special capabilities save the application work and avoid the
overhead of having to replay the picture multiple times.

The commands necessary to represent the image are encoded into a
highly-optimized journal file. The application releases when generation
of the journal is complete. In comparison with the spool files generated
by standard Windows drivers, journal files are very compact and are
the same size regardless of whether the print is in color or
monochrome.

Holding the information in a journal means that the entire document
can be replayed to simulate multiple hardware copies or to provide
last-to-first printing options.

The DECcolor Works Spool Manager is responsible for initiating the
DECcolor Works Despooler which replays the journal file back to the
mini-driver for the target device. Both the DECcolor Works Spool
Manager and DECcolor Works Despooler use a highly-efficient, multi-
threaded tasking system to ensure minimum impact on the foreground
application.
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Installing the DECcolor Works
Printer Driver

Installing the Driver with the Supplied Diskette
Before you can start printing from a Windows application, you must
first install a Windows printer driver control program. The DECcolor
Works printer driver is either provided on a diskette with your printer
or available as an option.

Note: Make a backup copy of the installation diskette before
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA

installing the DECcolor Works.
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA

Follow these steps to install DECcolor Works:

1. Switch on your printer and computer.

2. Insert a driver diskette into your diskette drive A: .

3. Start up Windows on your computer.

4. From Program Manager, select the File menu option Run....
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5. In the Run window, type “A:\SETUP” .

 

6. Click once on the OK button.

The installation program automatically performs the setup procedure.

Once the setup is complete, your printer driver is installed as the
default printer and the following window appears:

1 

Depending on your configuration and your use for the printer, you can
choose between three possibilities:

• You can modify the port to which your printer driver is attached by

selecting an option in the drop-down menu ←.

• You can returnt to Windows by clicking on the Continue button. A
specific window appears, allowing you to run the Windows print
test.

• You can modify your printer driver setup by clicking on the
Printer Setup button.
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Warning: Once you have installed the DECcolor Works printer driver
using Run  from the Program Manager  File  menu,
DECcolor Works becomes the default printer driver. From
this point on, to print in monochrome you must either switch
to the Digital Series-500 Monochrome  printer driver, or
select the Monochrome  option in the DECcolor Works
Printhead / Resolution  dialog box. You do not need to
change the print head if you make this selection.

Running the Color Windows Print Test

Once the printer driver installation is complete you can easily launch
the color Windows print test.

1. If you have closed the Digital-Series-500 program group window
after the printer driver installation, double click on the Digital-
Series-500 icon in the Program Manager window.

 

2. In the Digital-Series-500 group window, double click on the
Digital-Series-500 Color-Test icon. The Write  application is
launched.

 

Example Digital Series 500 Group Window

Caution: Check that the color print head is installed in the printer and
that the print head selection lever is set to COLOR.

3. From the File menu, choose Print Setup... and ensure Digital
Series 500-Color option is selected in the Printer  box.
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4. Click on the Options... button.

5. In the Printhead / Resolution dialog box, ensure that the Color
(CMY)  printing option is enabled.

6. Click on the OK  button.

7. In the Size: scroll box, select the paper size according to the paper
loaded in your printer.

 

Note: In the Source: scroll box, Upper tray (ASF1) corresponds to
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA

the built-in paper tray.
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA
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8. Click once on the OK button.

9. Select Print...  from the File menu.

10. Click once on the OK button.

11. Wait for the test printout.

12. Check the quality of the printout.

13. Close the Write  application.

Your printer is now set up for color printing from Windows
applications.

Printer Setup

The DECcolor Works printing system is designed to provide the best
print output default settings for your printer. If you need to alter the
default settings, the DECcolor Works printer driver provides you with
easy-to-use dialog boxes.

The setup options for the DECcolor Works printer driver can be
reached through the Windows Control Panel and through the Print
Setup option of most software applications. For more information on
setting up the printer, see Chapter 3 “Configuring the DECcolor Works
Printer Driver”.

Caution: With DECcolor Works you can create files using only True
Type and other installed scaleable fonts. Though you cannot
create files using resident fonts, these files can be printed in
graphic mode.
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Configuring the DECcolor Works
Printer Driver

Configuration Dialog Boxes
DECcolor Works has 6 main dialog boxes from which you choose the
printer’s configuration options. Using these dialog boxes, you can
configure:

• The paper size and paper source (tray).

• The paper type and print quality.

• The document type.

• The print head and print resolution.

• The brightness, contrast and color settings for printing images.

• The dithering (texture) patterns and diffusion control.

The setup options for the DECcolor Works printer driver can be
reached through the Windows Control Panel and through the Print
Setup option of most software applications.

Note: The default printer associated with DECcolor Works is Digital
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA

Series 500-Color. Select this printer setup option to print in
color using DECcolor Works.

AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA
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Dialog Box Buttons
At the bottom of the dialog box are 5 buttons. The function of each
button is described below:

1

Dialog Box Buttons and Context-Sensitive Help

OK Button

The OK  button closes the printer setup dialog and saves any changes
that may have been made. Click the OK  button if you open the setup
dialog and make alterations you wish to save.

Cancel Button

The Cancel button closes the printer setup dialog and discards any
changes that have been made. Click the Cancel button if you open the
setup dialog and make alterations that you decide you do not want.

Defaults Button

The Defaults button restores all of the driver settings to those you had
when it was first installed on your system.

Context-sensitive Help

Depending on the position of the mouse, context-sensitive help is

displayed at the bottom of the dialog box ←. This text helps you to

navigate around the dialog box, indicating the result of clicking on
each of the options and buttons.
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Configuring Your Printer

Paper Size / Source

Clicking on this dialog box lets you change the setting for the size of
paper (Letter, Legal, A4, etc.) and the source or paper tray from which
paper is to be fed to the printer.

Paper Size / Source Dialog Box

Choosing Paper Size

To choose the size of paper on which you want to print:

1. Select Paper Size / Source in the dialog box

2. In the Paper Size box click the paper size that you want to use. If
the paper size required is not displayed, use the scroll bar to locate
the correct size. You can also click one of the sizes displayed and
then use the arrow keys on your keyboard to move up and down the
list.

The graphic below the list in the dialog box displays the currently
selected paper size, orientation and printable area (shown by the
dimensions within the dotted lines).
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Caution: Make sure you choose a Paper Size option that is
appropriate to the paper source you are using, in order to
avoid printing problems.

Setting a Custom (User Defined) Paper Size

When the User Defined option is selected from the Paper Size list, a
small popup window appears into which the width and height of the
paper may be entered. Note that the dimensions entered should be the
full size of the paper. Note also that the printable area will normally be
slightly less than these dimensions.

The dimensions are entered either in inches or millimeters depending
on the international settings within the Windows Control Panel.

Orientation: Portrait / Landscape

The Paper Size box also contains the Portrait  and Landscape options.
Portrait and Landscape orientations define the way that the image is
printed on paper. For most paper types portrait is tall and Landscape is
wide

The orientation for envelope sizes is often treated differently to
standard paper sizes (Letter, A4, etc.). To confirm the correct
orientation for envelopes, select an envelope size and the graphic
below displays the paper selection using the appropriate size and
orientation.

Orientation of Envelopes and A5 Paper Format

The orientation for these sizes is often treated differently than for
standard paper sizes (Letter, A4, etc.). To confirm the correct
orientation for envelopes, select an envelope size or the A5 format.
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Choosing Paper Source
In the Paper Source dialog box use the drop-down list to select a
paper source for your printer.

Caution: Make sure you choose a Paper Size option that is
appropriate to the Paper Source you are using, in order to
avoid printing problems.

Use the following table as a guide to which paper sizes can be used
with each paper source:

Paper Source Paper Sizes

Upper tray (ASF1)
Lower tray (ASF2)

A4, A5, US Letter, Legal
User Defined

Manual Feed A4, A5, US Letter, US Legal, Executive
User Defined *

Envelope Manual
Feed

All envelope formats
User Defined *

Tractor (Optional) Fanfold
User Defined *

* Make sure that dimensions are within limits of selected paper device.

Printing Multiple Copies
Enter the number of copies that you would like to generate for your
print job in the Copies box.

Collate

When this option is selected, all pages of the document are printed
before the next copy set is generated. If this option is not chosen and
you print multiple copies, pages are not printed in sequence. The same
pages of each copy are printed together.

Reverse Page Order
Selecting this option causes your print job to begin printing with the
last page of the document. This function is commonly called Last-to-
first printing.
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Paper Types / Print Quality

Paper Type / Print Quality Dialog Box

Paper Type

By selecting Paper Type / Print Quality you can select which paper
type (plain paper, special coated paper, etc.) you are using by clicking
on one of the options in the Paper Type box.

The graphic display on the right of the dialog box changes with the
selection of each type of paper.
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Paper Type Quality

Plain Paper The quality of the plain paper you use has a
strong impact on the quality of color printing.
Try different types of plain paper to optimize
your color print quality.

Transparency Use transparencies that are specifically made
for inkjet printing.

Glossy Paper This type of paper provides the best results
with color printing.

Coated Paper This type of paper, which has a smooth finish,
provides good results with color printing.

Print Quality

Print Quality  controls the quality of the document to be produced, by
setting a combination of printing speed, ink use and inking speed.

The table below indicates the settings for each of the Print Quality
options:

Print Quality Printing Speed Ink Use Inking Speed

Standard High Normal High (Default)

Draft High Minimum High

Economy High Reduced High

High Quality Normal Normal Medium

Presentation Normal Normal Low

Use plain paper with the Standard print quality setting if you do not
require particularly bright or clearly defined colors.
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Printing Speed: Normal or High

The printing speed setting can be normal- or high-speed printing.

Ink Use : Normal, Reduced or Minimum

Although the resolution and definition of the image remains the same,
the number of dots printed is reduced to save ink. This may, however,
lead to a reduction in luminosity of some colors.

Inking Speed : High, Medium or Low

This means that each single printed band (or line of bitmap) can be
printed in one or several passes, using all or part of the necessary
nozzles. Consequently, the inking speed is inversely proportional to the
print quality. The lower the speed, the higher the quality.

Choosing Print Quality

Before printing a final version of your document, use plain paper with
the Draft  or Economy settings to get an idea of how your final print
will look.

The Economy print quality setting saves ink but can result in lower
luminosity of color documents. However, with some types of coated
paper, the result of using Economy may be better than using Standard
print quality.

When using transparencies, glossy or coated paper, choose the
Presentation print quality setting.

When using the monochrome print head, the High Quality  settings are
those of Presentation.
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Printhead / Resolution

Printhead / Resolution Dialog Box

Printhead

This dialog box let you choose monochrome or color printing. The
color option shows that the printer’s print head mixes cyan, magenta
and yellow (CMY), to create different color combinations.
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If You Install the Monochrome Print Head

If you change the print head from color to monochrome, you MUST
select Monochrome in the Printhead / Resolution dialog box. If you
do not select Monochrome and you send a file to be printed with the
monochrome print head installed, the printer will not print the file and
the printer’s Color indicator flashes.

To abort the print, click on the Stop button on the DECcolor Works
Despooler dialog box. To completely abort the print you must either
select Monochrome in the dialog box or reinstall the color print head.

When you change the Printhead setting from monochrome to color or
from monochrome to color, the following dialog box appears:

Click on OK  to select the print head setting.

Caution: Remember to also select OK  in the Printhead dialog box to
confirm the setting.

Resolution

This box displays print resolution as number of dots per inch (dpi) that
can be selected for your printer. The default print resolution is 300x300
dots per inch (300 dpi), even if Draft  is selected from the Print
Quality  dialog box.

In general, use a low resolution for draft documents and proof reading
purposes.
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Document Type

Document Type Dialog Box

The document type option is used to quickly configure the driver for a
particular type of document.

When a document type is selected other options within the driver setup
are changed to re-configure the driver, as follows :

Document Types Print Quality Dithering Print Head

Automatic High Quality High Quality
Diffusion

Monochrome
/ Color

Monochrome
Report

Standard Fine Pattern Monochrome

Color Report Standard Fine Pattern Color

Grayscale
Picture

Presentation High Quality
Diffusion

Monochrome

Color Picture Presentation High Quality
Diffusion

Color

Draft Printing Draft Coarse Pattern Monochrome
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In any case, you will then only need to check in addition if your Paper
Type, Paper Size and Paper Source selections correspond to your
requirements, and your printer is ready.

Note: You are free to change any of the options that are affected by
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA

the document type but if you do so, the current document type
will be de-selected.

AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA
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Image Settings

Image Settings Dialog Box

Modifying Image Settings

The Image box allows you to modify the default image settings used
by the DECcolor Works printer driver. Since the printer driver uses
default settings designed to give you the best results, you should not
need to alter these settings. This dialog box is provided for additional
requirements.

If you want to print with no colors and so select Monochrome using
the Printhead / Resolution dialog box, you can only control the
Brightness, Contrast and Ink Density Correction settings in the
Image dialog box.

When you modify the image settings, the image in the dialog box
shows the change in brightness and contrast.
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Modifying Color Settings

Color saturation (the amount of color ink printed), the relative
strengths of Red, Green, Blue and ink color correction can also be
modified if you have selected Color (CMY) in the Printhead dialog
box.

When you modify the color settings, the image in the dialog box
shows the change in colors.

Note: The image may not appear exactly as you would expect if
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA

your color monitor does not support enough colors.
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA

Changing the Image in the Dialog Box

If you want to load another bitmap file (.BMP) in place of the default,
you can do so by double-clicking in the image area. This displays a
Change Image Control Bitmap file dialog box and will allow you to
choose another bitmap file. Depending on the size of the bit map you
choose, only a portion of the bit map may be displayed. Bitmaps must
be 1-bit, 4-bit, or 8-bit types.
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Dithering

Dithering Dialog Box

By selecting Dithering  you can select the fine dot pattern with which
images are created when they are printed. In general, fine or coarse
pattern dithering produces textured images and is suitable for text and
simple, solid graphics.

Caution: Make sure you choose the Diffusion option that is
appropriate to the type of picture you are printing (see the
table on the next page). Print results may be unsatisfactoy if
you have not chosen the correct setting.
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Use the following table as a guide to selecting the dithering setting:

Dither Use for...

No dithering Text and no graphics. This is the
fastest setting.

Line art Pattern Simple line art and computer
graphics.

Fine Pattern Graphic images with significant
detail but limited shading.

Coarse Pattern Graphic images with limited
detail and shading.

Line art Diffusion Line art with fine gradations,
such as pencil drawings.

Standard Diffusion Less-detailed images. This is a
faster dithering setting.

High Quality Diffusion Photographic images or
equivalent drawings.

Presentation Quality Diffusion Detailed diagrams or drawings,
such as those produced with
CorelDRAW!.

The No dithering option can be selected if you only want to print plain
(non-dithered) text.

To print images with plain flat colors, choose Pattern values and to
print images with shades of colors, choose Diffusion options in the
Dithering  dialog box.

Use one of the Diffusion options if you want to enhance photographs
and produce smoother-quality pictures.

Note: Different types of image react differently to the same
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA

Diffusion option. Try different Diffusion options to learn
which ones are best suited to your output needs.

AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA
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4

Spool Manager and Despooler

DECcolor Works Spool Manager
The DECcolor Works Spool Manager manages communication
between the computer and the printer. Using the Spool Manager, your
computer monitors and controls printing. Spool manager handles
documents sent for printing and the print queue to which each
document is assigned.

When DECcolor Works releases your application software from
printing, a journal file is created in the default spool directory. When a
journal file is created, the DECcolor Works Spool Manager is notified
and assigns it to the appropriate queue. When the journal file comes to
the front of the queue it is submitted to the DECcolor Works Despooler
and replayed to the printer.

Note: Spool Manager is specific to DECcolor Works. You cannot
AAAA
AAAA

AAAA
AAAA

AAAA
AAAA

AAAA
AAAA

AAAA
AAAA

AAAA
AAAA

AAAA
AAAA

AAAA
AAAA

AAAA
AAAA

AAAA
AAAA

AAAA
AAAA

AAAA
AAAA

AAAA
AAAA

AAAA
AAAA

AAAA
AAAA

AAAA
AAAA

AAAA
AAAA

AAAA
AAAA

AAAA
AAAA

AA
AA

access other Windows printer drivers from Spool Manager.
When printing on a local printer, Spool Manager overrides
Print Manager which can be turned on or off indifferently. If
printing over a network, Print Manager should be on.

AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA
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The DECcolor Works Spool Manager Window

The Spool Manager window shows the list of DECcolor Works printer
queues and journals currently printing or waiting for printing.

DECcolor Works Spool Manager Window

Queues

Queues shown in normal intensity represent printers that are supported
by DECcolor Works.

Queues shown in low intensity are supported by other (conventional)
Windows printer drivers.

You can change the options of a DECcolor Works print queue by
double-clicking on it or by clicking once to select it and then choosing
an option from the Queue menu.

Journal Files

Journal files are the print files generated by DECcolor Works. When a
journal file is created, it can be sent to the printer or stored for printing
later. In the Spool Manager window journal files are shown in their
relevant print queue. You can stop a journal file printing,  place journal
files on hold, delete a journal file or re-queue a journal file for later
printing by double-clicking a journal file entry in the Spool Manager
window.

Alternatively you can click a journal file entry and then choose an
option from the Document menu to manage the file.
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The Queue Menu

The Queue menu allows you to place DECcolor Works print queues on
hold, release them to allow journal files to be printed and identify
queues as local or remote (network printing). The following options are
available:

Holding or Releasing a Queue

1. Click on the queue to select it.

2. Choose the Hold option from the Queue menu.

A check mark beside the Hold option indicates the queue is currently
on hold. When a queue is on hold, the Spool Manager places a wait
symbol beside the printer icon associated with the queue, and journal
files are not submitted for printing.

Using The Windows Print Manager

The DECcolor Works Despooler normally prints directly to the printer.
If you are using a network or wish to schedule print jobs through the
conventional Windows Print Manager, follow these steps:

1. Click the queue.

2. Either double-click the queue or select the Setup option from the
Queue menu.

3. Click in the Use Print Manager box for this port option and
choose the OK  button.

Network Printing

DECcolor Works allows you to send journal files from your computer
to a shared directory on a network server. These can then be printed by
another workstation set up to run the DECcolor Works Spool Manager
and associated DECcolor Works printer driver(s). You can do this as
follows:
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Host Setup

1. Click on the queue.

2. Either double-click the queue or select the Setup option from the
Queue menu.

3. Select the Spool to remote printer option.

4. Click the Browse button and select the spool directory on the
remote server which should receive journal files from the spool
manager.

Remote Setup

1. Install the DECcolor Works printing system and the required
DECcolor Works printer driver(s) using the Windows Control
Panel.

2. Run the DECcolor Works Spool Manager by executing
SWSPLMGR.EXE from the WINDOWS\SYSTEM directory.

3. Either double-click the queue or select the Setup option from the
Queue menu.

4. Select the Remote Despool tab and click the Printing from
remote queues option.

5. Click the Browse button and select the spool directory on the
remote server which will hold journal files from host workstations.

Journals will be identified by the DECcolor Works Spool Manager and
submitted for printing.

Note: This feature is quite different from the traditional remote-
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA

printer spooling provided by most network operating systems.
Use your network to redirect the printer LPTx: ports in the
usual way to take advantage of that feature. You may also
need to enable the Windows Print Manager as described
above on some network operating systems when port re-
direction is utilized.

AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA
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The Document Menu

The Document menu allows you to control journal files in your
DECcolor Works print queue. Journals can be held, re-printed, deleted
or kept for subsequent re-printing.

To select options appropriate to a journal file, either double-click it or
select Options from the Document menu.

The View Menu

The View menu allows you to limit the amount of information that the
DECcolor Works Spool Manager gives you. In addition, you can
control the display of the DECcolor Works Despooler pop-up. When
options in the View menu are selected, the DECcolor Works Spool
Manager places a check mark beside them.

If the Show Despool Popup is cleared (no check mark is beside it), the
DECcolor Works Despooler window will not appear when journal files
are submitted for printing. It will appear, however, if an error is
reported by the printer.

The Options Menu

The Options menu controls the default spool directory, timer and font
selections as follows:

Default Spool Directory

Choose this option from the Options menu to override the default
TEMP directory setting. Journal files will be sent to this directory
instead. This option is equivalent to the Spool Directory setting in the
Queue Menu Setup option except that it applies to all queues.

Timers

The Update Timer tells the DECcolor Works Spool Manager how
often to refresh the information displayed in the DECcolor Works
Spool Manager window. The Remote Timer tells a remote DECcolor
Works Spool Manager how often to look for new journal files in a
network directory. See the Queue menu for more details about network
printing.
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Font

This option allows you to set the default font that the DECcolor Works
Spool Manager uses for displaying information in the spool manager
window.

The Help Menu

The Help menu provides copyright, trademark and version information
about the DECcolor Works Spool Manager through the About option.
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The DECcolor Works Despooler
Though the Despooler window is displayed when you are printing, the
Despooler is essentially working in background mode, allowing you to
work with the current and other applications.

When a journal file is processed by the DECcolor Works Spool
Manager, it is submitted to the DECcolor Works Despooler. The
progress of the current page is shown by the image of a document in

the upper right of the Despooler window ←.

2 4

3

1

DECcolor Works Despooler Dialog Box

Each page of the document is divided into one or more horizontal
bands for processing. Once a band is complete, that data is sent to the
printer and the despooler starts to process the next band. If your
computer has little free memory or you are printing a complex
document, a number of bands appear in the dialog box.

Control Buttons
The Despooler window contains 3 control buttons that you can use to
manage printing:

• The Stop button ↑ aborts the print.

• The Pause button → temporarily halts the print. Click the button

to pause the print and click again to re-start printing.
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• The Rewind button ↓ stops the current print and re-queues the

journal file (print file) from the beginning. Use this button to re-
launch prints without having re-print from the application.

Status Messages

The DECcolor Works Despooler shows the progress of the current print

job and identifies printer status information ← such as “out of paper”

“printer off line” etc.

Status messages and symbols representing error conditions are
displayed on the image of your printer in the despooler window. The
following example shows an error message and graphic indicator that
the printer is out of paper.

1

Despooler Dialog Box with Status Message

When you correct a problem with the printer the despooler senses this
and continues with the print job. If a serious error occurs, such as
printer power failure, it is suggested that you re-queue the journal and
print it again.

Note: If you have cleared (no check mark is beside it) the Show
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA

Despool Popup option in the View Menu of the DECcolor
Works Spool Manager, then the DECcolor Works Despooler
pop-up will only appear if a printer status error occurs.

AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA
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About Button and Help Button

The About and Help buttons provide supplementary information about
the DECcolor Works Despooler.
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5

Troubleshooting

When a printer error occurs, there are two sources of information that help
you to resolve the problem. They are:

• The Despooler dialog box, which displays text and graphical
information on the error that has occurred, and provides tools to rectify
the problem (stop, pause and rewind buttons).

• The printer’s operator panel indicators and buttons, which can be used
to diagnose and rectify the problem.

The following table describes some of the more common errors that you
may encounter when printing with the DECcolor Works printer driver. The
left column describes the symptom (or combination of symptoms) that
indicate that a print error has occurred.

The center column lists the possible causes of the error. Where 2 different
causes produce the same symptoms, the different causes and their
corresponding solutions are lettered (A and B) in the table.

The right hand column describes the action you should take to resolve the
problem. Actions that correspond to each cause are listed opposite each
cause in the table.
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Troubleshooting Printer Problems

Printer Setup Problems

Symptoms Possible Cause Action / Resolution

- Printer not printing.

- Despooler timer active.

- Red cross on Despooler
window.

A.Printer is not turned on.

B.Printer is off line.

A.Press the power switch to
turn on the printer.

B.Press the On Line button on
the operator panel.

- Printer not printing.

- Color indicator flashing.

- Despooler timer active.

A.Print head selection lever
in wrong position.

B.Wrong combination of
print head and printer set
up (color or monochrome).

A.Move the print head
selection lever to the correct
position.

B.Abort the print by clicking on
the stop button in the
Despooler window.

When the Despooler window
disappears, turn off the
printer, wait a few seconds,
and turn it on again.

In the DECcolor Works
Printhead/Resolution dialog
box, select Monochrome  or
Color .

- Printer not printing.

- Despooler window
shows red cross and
“Out of Paper” error
message.

Parallel printer cable is not
connected.

Check that the printer’s
parallel cable is connected
to both the printer and the
computer.

- Printer not printing.

- Despooler window does
not appear.

- Color indicator flashes.

Wrong printer driver
selected to print the file.

Delete the document from
the Windows Print
Manager  or reset the
printer.

To reset the printer, turn it
off, wait a few seconds, and
turn it back on.
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Symptoms Possible Cause Action / Resolution

- Printer not printing

- Despooler timer active.

- Ink/Paper indicator
flashing (double
sequence).

Manual Feed  has been
selected in the paper
source dialog box for
printing from another
paper source (upper or
lower paper tray).

Load paper manually to
print, or abort the print from
the Despooler, turn off the
printer, wait a few seconds,
and turn it on again.

- Printer not printing.

- Despooler timer active.

- Wrong port is identified
in the Despooler
window.

Wrong port is associated
with the printer.

Abort the print by clicking on
the stop button in the
Despooler window.

When the Despooler window
disappears, turn off the
printer, wait a few seconds,
and turn it on again.

From the Windows Control
Panel Printers  dialog box
use the Connect...  button to
associate the printer with the
correct port.
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Print Head and Paper Problems

Symptoms Possible Cause Action / Resolution

- Printer not printing

- Despooler timer active.

- Ink/Paper indicator
flashing (double
sequence).

A. No print head installed.

B. Monochrome cartridge is
out of ink.

A. Install print head in the
printer and press the Install
button.

B. Install a new monochrome
cartridge.

- Printer not printing.

- Despooler timer active.

- Ink/Paper indicator
flashing.

- LQ/NLQ/Draft indicators
flashing in sequence.

Print head not correctly
installed.

Correctly reinstall the print
head in the printer.

- Faded color print quality. Color print head is empty. Replace the color print
head.

- Printer not printing.

- Despooler window
shows red cross and
“Out of Paper” error
message.

- Ink/Paper indicators
flashing (double
sequence).

A.Paper tray not installed.

B.No paper in paper tray.

C.Paper is torn or jammed in
the printer.

D.Wrong paper source
selection.

A. Insert the paper tray.

B. Insert paper in the paper
tray.

C.Clear the paper jam.

D.Choose the correct paper
source selection in the
printer setup.
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Questions and Answers
The following common questions and answers provide important
information about using DECcolor Works.

Changing Dither Options
Q. Do I really need to change ink or Dither options in

the printer driver setup?

A. Not really! You can simply use the default printer
driver settings for most printing needs. However, if you
want a different resolution or special paper for
presentations, you'll need to change some settings.

Q. I am trying to print an image. Whatever Dither
option I select in the printer driver, the resulting
output always looks the same. What is the problem?

A. It may be that the image you are trying to print has
already been dithered by your software and the
software is overriding the driver's dither setting. Look
at your software for an option that allows you to use
printer dithers so that the DECcolor Works printer
driver can do its job. You can also try printing the
image with another application.

Defaults Button
Q. What does the Defaults button do?

A. It restores the driver settings to those you have when
DECcolor Works is first installed on your system.

Diffusion Options
Q. Although I have selected one of the Diffusion dither

options, my pictures do not appear to be diffused.
Why?

A. Your software may be overriding the driver's dither
processing. Look at your software for an option that
allows you to use printer dithers so that the DECcolor
Works printer driver can do its job.
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Q. I am printing a word processing document and my
print time is quite slow. What is the reason for this?

A. The Diffusion (High Quality) option in the dithering
settings dialog box is generally the default setting on
most DECcolor Works printer drivers. Although this
generally gives the best print quality for graphics,
when printing text-intensive documents, the pattern
options provide greatly-enhanced print performance.

Printing to a Remote Printer
Q. I cannot seem to print to a Windows remote printer

from my Windows for WorkGroups or LAN setup.
What is the problem?

A. You need to direct the DECcolor Works Spool
Manager to print through the standard Windows Print
Manager. Do this by running SWSPLMGR.EXE.
Double-click the printer queue that you wish to direct
through Print Manager. Select the Use Print Manager
for this port option. Choose the OK  button and close
the application. Subsequent prints will be sent through
the Windows Print Manager by the DECcolor Works
Despooler.

Q. I would like to send my journal files to a remote
DECcolor Works Spool Manager across my
network. Can I do this?

A. Yes. Use the Search menu of the Help window to learn
about the DECcolor Works.

Windows and OS/2
Q. I cannot print from a Windows session under OS/2 .

What is the problem?

A. You need to direct DECcolor Works Spool Manager to
print through the Win-OS/2 Print Manager. The
procedure for doing this is described two answers
above.
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